PostScript 3 Supplement

@ Windows Configuration
@ MacOS Configuration
@ Using PostScript 3
Printer Utility for Mac

Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the
Safety Information in "About This Machine" before using the machine.



Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Notes:

Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.



Manuails for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

ﬂlmportant
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Media differ according to manual.
The printed and electronic versions of a manual have the same contents.

Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

Depending on which country you are in, there may also be html manuals. To
view these manuals, a Web browser must be installed.

About This Machine

Be sure to read the Safety Information in this manual before using the ma-
chine.

This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMs provided.

General Settings Guide

Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.

Trouble Shooting
Provides a guide to solving common problems, and explains how to replace
paper, toner, and other consumables.

Security Reference

This manual is for administrators of the machine. It explains security func-
tions that the administrators can use to protect data from being tampered
with, or prevent the machine from unauthorized use.

Also refer to this manual for the procedures for registering administrators, as
well as setting user and administrator authentication.

Copy Reference
Explains Copier functions and operations. Also refer to this manual for expla-
nations on how to place originals.

Facsimile Reference
Explains Facsimile functions and operations.

Printer Reference
Explains Printer functions and operations.

Scanner Reference
Explains Scanner functions and operations.



< Network Guide
Explains how to configure and operate the machine in a network environ-

ment, and use the software provided.
This manual covers all models, and includes descriptions of functions and
settings that might not be available on this machine. Images, illustrations, and
information about operating systems that are supported might also differ
slightly from those of this machine.
< Other manuals
* Manuals for This Machine
¢ Safety Information
* Quick Reference Copy Guide
® Quick Reference Fax Guide
¢ Quick Reference Printer Guide
¢ Quick Reference Scanner Guide
* PostScript 3 Supplement
¢ UNIX Supplement
* Manuals for DeskTopBinder Lite
* DeskTopBinder Lite Setup Guide
¢ DeskTopBinder Introduction Guide
e Auto Document Link Guide

& Note
O Manuals provided are specific to machine types.

O Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

O For “UNIX Supplement”, please visit our Web site or consult an authorized
dealer.

O “PostScript3 Supplement” and “UNIX Supplement” include descriptions of
functions and settings that might not be available on this machine.
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How to Read This Manual

Symbols

This manual uses the following symbols:

/\ WARNING:

Indicates important safety notes.

Ignoring these notes could result in serious injury or death. Be sure to read these
notes. They can be found in the “Safety Information” section of About This Ma-
chine.

/\ CAUTION:

Indicates important safety notes.

Ignoring these notes could result in moderate or minor injury, or damage to the

machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

*gklmportant

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

& Note

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

A Reference

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.

[]

Indicates the names of keys that appear on the machine’s display panel.

[]

Indicates the names of keys on the machine’s control panel.
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1. Windows Configuration

Using the DeskTopBinder -
SmartDeviceMonitor for Client Port

Installing DeskTopBinder - SmartDeviceMonitor for Client

ﬁ*lmportant

O Toinstall DeskTopBinder - SmartDeviceMonitor for Client under Windows 2000
/ XP Professional, Windows Server 2003, and Windows NT 4.0, you must have
an account that has Manage Printers permission. Log on as an Administrator.

O Install DeskTopBinder - SmartDeviceMonitor for Client before installing the
printer driver when using the DeskTopBinder - SmartDeviceMonitor for Cli-
ent port.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [DeskTopBinder - SmartDeviceMonitor for Client].

B Select an interface language, and then click [OK].
The default interface language is English.

B The message to quit all other applications appears. Quit all applications,
and then click [Next >].

ﬂ The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes].

8 Follow the instructions on the display and click [Next >] to proceed next step.

g After the installation is completed, select one of the options to restart the
computer either now or later, and click [Complete].

Restart the computer to complete installation.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.



Windows Configuration

Installing the PostScript 3 Printer Driver (Windows 95 /98 / Me -
TCP/IP)

ﬂ Quit all applications currently running.

B) insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crick Next >].

(3 Click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the machine whose driver you want to install, and then
click [Next >].

8 In the [Available ports:] box, click [Printer Port], and then click [Next >].

g Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[[U Specify whether or not to print a test page, and then click [Finish].

ﬂ] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

[B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B On the [Details] tab, click [Add Port...].

[E] Click [DeskTop Binder-SmartDeviceMonitor] in the [Other] list, and then click
[OK].

[B Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.



Using the DeskTopBinder - SmartDeviceMonitor for Client Port

m Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], enter the IP address or host
name of the machine, and then click [OK].

You cannot add an IP address partially similar to the one already used. For
example, if “192.168.0.2” is in use, “192.168.0.2xx” cannot be used. Similarly,
if “192.168.0.20” is in use, “192.168.0.2” cannot be used.

[ﬂ Check that the selected port is highlighted in [Print to the following port], and
then click [OK].

[B Restart the computer to complete installation.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows 95/98 / Me - IPP)

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crici Next >].

[3 click [Local Printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the machine whose driver you want to install, and then
click [Next >].

8 In the [Available ports:] box, click [Printer Port], and then click [Next >].

g Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.




Windows Configuration

[ﬁ] Specify whether or not to print a test page, and then click [Finish].

ﬂ] On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

m Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B On the [Details] tab, click [Add Port...].

[I] Click [DeskTop Binder-SmartDeviceMonitor] in the [Other] list, and then click
[OK].

B click pipe).

[E In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er's address.

If the server authentification is issued, to enable SSL ( a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter "http:/ /printer's address/ipp" as the printer's address.

[ﬂ Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

iE Click [Detailed Settings] to configure proxy server, IPP user name, and other
settings. Make these settings, and then click [OK].
You can enter "http:/ /printer's address/ipp" as the printer's address.

B click [ok).

EID Check that the selected port is highlighted in [Print to the following port], and
then click [OK] .

Ei] Restart the computer to complete installation.

4 Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.



Using the DeskTopBinder - SmartDeviceMonitor for Client Port

Installing the PostScript 3 Printer Driver (Windows 2000 - TCP/IP)

ﬂlmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crici Next >].

B Click [Local printer], and then click [Next >].

ﬂ Click [Create a new port:].

8 Click [DeskTop Binder-SmartDeviceMonitor], and then click [Next >].

g Click [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

[m Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

ﬂ] Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[ﬂ Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Specify whether or not to share the printer, and then click [Next >].
ﬂ] Specify whether or not to print a test page, and then click [Next >].

B crick [Finish].
The printer driver installation starts.



Windows Configuration

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows 2000 - IPP)

ﬁ*lmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.
The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next>].

B Click [Local printer attached to this computer], and then click [Next >].
ﬂ Click [Create a new port:].

B Click [DeskTop Binder-SmartDeviceMonitor], and then click [Next >].
B crick pepy.

[m In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-
er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter "http:/ /printer's address/ipp" as the printer's address.



Using the DeskTopBinder - SmartDeviceMonitor for Client Port

ﬂ] Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the name of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

[ﬂ Click [Detailed Settings] to configure proxy server, the IPP user name and oth-
er settings. Specify the necessary settings, and then click [OK].
For information about the settings, see DeskTopBinder - SmartDeviceMoni-
tor for Client Help.

B ciick [oki.

ﬂ] Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

iE Change the printer name if you want, and then click [Next >].
[E Specify whether or not to print a test page, and then click [Next >].

[ﬂ Click [Finish].
The printer driver installation starts.

4 Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003 - TCP/IP)

ﬁklmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.
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Windows Configuration

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next>].

B Click [Local printer attached to this computer.], and then click [Next >].
ﬂ Click [Create a new port:].

B Click [DeskTop Binder-SmartDeviceMonitor], and then click [Next >].

B ciick [TCP/IP], and then click [Search].
A list of printers using TCP/IP appears.

m Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

m Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

m Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Specify whether or not to print a test page, and then click [Next >].

0 click [Finish].
The printer driver installation starts.

@ Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe”on the CD-ROM root directory.



Using the DeskTopBinder - SmartDeviceMonitor for Client Port

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003 - IPP)

ﬂlmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crici Next >].

B Click [Local printer attached to this computer.], and then click [Next >].

ﬂ Click [Create a new port:].

8 Click [DeskTop Binder-SmartDeviceMonitor], and then click [Next >].

B crick pery.

[[U In the [Printer URL] box, enter “http://(printer's address)/printer” as the print-

er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter "http:/ /printer's address/ipp" as the printer's address.

ﬂ] Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

11
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Windows Configuration

[ Click [Detailed Settings] to make necessary settings.
For information about the settings, see DeskTopBinder - SmartDeviceMoni-
tor for Client Help.

B click [ok).

m Check that the name of the printer driver you want to install is selected, and
then click [Next >].

[B Change the name of the printer if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

m Specify whether or not to print a test page, and then click [Next >].

W click [Finish].
The printer driver installation starts.

@ Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - TCP/IP)

ﬂlmportant
O Installing this printer driver requires Administrators permission. Log on us-

ing an account that has Administrators permission.

O If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.

ﬂ Double-click on "SETUP.EXE" in the downloaded folder.
Add Printer Wizard starts.

B Select [My Computer], and then click [Next >].
E) click [Add Port..].
ﬂ Click [DeskTop Binder-SmartDeviceMonitor], and then click [New Port...].

ﬂ Click [TCP/IP], and then click [Search].
A list of printers using [TCP/IP] appears.

B Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.



Using the DeskTopBinder - SmartDeviceMonitor for Client Port

ﬂ Click [Close] to close the [Printer Port] dialog box.
B Click [Next >].

g Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[m Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

ﬂ] Specify whether or not to share the printer, and then click [Next >].

[E] Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

[B Restart the computer to complete installation if necessary.

& Note

O A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

Installing the PostScript 3 Printer Driver (Windows NT 4.0 - IPP)

ﬁ*lmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.

ﬂ Double-click on "SETUP.EXE" in the downloaded folder.
Add Printer Wizard starts.

Ed select [My Computer], and then click [Next >].

E) Click [Add Port..].

ﬂ Click [DeskTop Binder-SmartDeviceMonitor], and then click [New Port...].
B click pieey.

13
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E In the [Printer URL] box, enter “http://(printer's address)/printer”as the print-
er's address.

If the server authentification is issued, to enable SSL (a protocol for encrypted
communication), enter “https://(printer's address)/printer” (Internet Ex-
plorer 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer

You can enter "http:/ /printer's address/ipp" as the printer's address.

ﬂ Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

8 Click [Detailed Settings] to make necessary settings.

For information about the settings, see DeskTopBinder - SmartDeviceMoni-
tor for Client Help.

B crick [ok).
[ click [Close] to close the [Printer Port] dialog box.
0 click [Next >].

[ﬂ Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

ﬂ] Specify whether or not to share the printer, and then click [Next >].

iE Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

[E Restart the computer to complete installation if necessary.

& Note
O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Changing the Port Settings for DeskTopBinder -
SmartDeviceMonitor for Client

Follow the procedure below to change the DeskTopBinder - SmartDeviceMoni-
tor for Client settings, such as TCP/IP timeout, recovery/parallel printing, and
printer groups.

Windows 95/ 98:

ﬂ Open the [Printers] window from the [Start] menu.

g In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

E) Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

ﬂ Open the [Printers] window from the [Start] menu.

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

E] On the [Ports] tab, click [Configure Port]
The [Port Configuration] dialog box appears.

Windows XP, Windows Server 2003:

ﬂ Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.
ﬂ Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.
8 Click the [Port] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.
e For TCP/IP, timeout setting can be configured.
¢ User, proxy, and timeout settings can be configured for IPP.

p Reference

For information about these settings, see DeskTopBinder - SmartDevice-
Monitor for Client Help.

15
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How to enable Recovery/Parallel Printing

If no settings on the [Recovery/Parallel Printing] tab are available, follow the proce-
dure below.

ﬂ Start DeskTopBinder - SmartDeviceMonitor for Client, and then right-
click the DeskTopBinder - SmartDeviceMonitor for Client icon on the task-
bar.

ﬂ Click [Extended Features Settings], and then select the [Set Recovery/Parallel
Printing for each port] check box.

B Click [OK] to close the [Extended Features Settings] dialog box
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Using the Standard TCP/IP Port

Installing the PostScript 3 Printer Driver (Windows 2000)

ﬁ*lmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the
DeskTop Binder-SmartDeviceMonitor port.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next>].

[3 click [Local printer], and then click [Next >].

ﬂ Click [Create a new port:].

B Click [Standard TCP/IP Port], and then click [Next >].

ﬂ Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[m Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

B Click [Next ]
[B Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[B Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

17



18

Windows Configuration

ﬂ] Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

B Click [Next >].
m Specify whether or not to print a test page, and then click [Next >].

W click [Finish].
The printer driver installation starts.

& Note
O A user code can be set after the printer driver installation . For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

ﬂlmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the
DeskTop Binder-SmartDeviceMonitor port.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next>].

B Click [Local printer attached to this printer], and then click [Next >].

ﬂ Click [Create a new port:].

B Click [Standard TCP/IP Port] in [Create a new port], and then click [Next >].
ﬂ Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
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[m Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When screen for Device selection appears, select "RICOH NetworkPrinter
Driver C Model".

B Click [Next ]
[EJ Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[B Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

ﬂ] Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

iE Specify whether or not to print a test page, and then click [Next >].

0@ click [Finish].
The printer driver installation starts.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

19
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Using the LPR Port

Installing the PostScript 3 Printer Driver (Windows 2000)

ﬁ*lmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next>].

(3 Click [Local printer], and then click [Next >].
ﬂ Click [Create a new port:].

8 Click [LPR Port], and then click [Next >].

ﬂ Enter the printer's IP address in the [Name or address of server providing Ipd]
box.

[E] Enter “1p” in the [Name of printer or print queue on that server] box, and then click
[OK].

ﬂ] Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[ﬂ Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

B Click [Next >].
ﬂ] Specify whether or not to print a test page, and then click [Next >].

B crick [Finish].
The printer driver installation starts.
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& Note
O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

ﬁ*lmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O In an IPv6 environment, you cannot use the LPR Port. Use the DeskTop Bind-
er-SmartDeviceMonitor port.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B select [My Computer], and then click [Next >].

B Click [Local Printer attached to this computer.], and then click [Next >].
ﬂ Click [Create a new port:].

B Click [LPR Port] in [Create a new port], and then click [Next >].

ﬂ Enter the printer's IP address in the [Name or address of server providing Ipd]
box.

[E] Enter “1p” in the [Name of printer or print queue on that server box], and then click
[OK].

ﬂ] Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[ﬂ Change the printer name if you want, and then click [Next >].

Select the [Yes] check box to configure the printer as default. o1
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B Click [Next >].
m Specify whether or not to print a test page, and then click [Next >].

B click [Finish].
The printer driver installation starts.

4 Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory."

Installing the PostScript 3 Printer Driver (Windows NT 4.0)

ﬂlmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.

ﬂ Double-click on "SETUP.EXE" in the downloaded folder.
Add Printer Wizard starts.

Ed select [My Computer], and then click [Next >].
E) Click [Add Port..].
O3 select [LPR Port], and then click [New Port...].

B Enter the printer's IP address in the [Name or address of server providing Ipd]
box.

B Enter “Ip” in the [Name of printer or print queue on that server:] box, and then
click [OK].

1 ciick [Close] to close the [Printer Port] dialog box.
B crici Next >].

g Check that the name of the machine whose driver you want to install is se-
lected, and then click [Next >].

[m Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

ﬂ] Specify whether or not to share the printer, and then click [Next >].
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[B Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

[B Restart the computer to complete installation.

@ Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the Windows Network Printer

Installing the PostScript 3 Printer Driver (Windows 95 /98 / Me)

ﬁ*lmportant

O If you print from a print server connected to the printer using the DeskTop
Binder-SmartDeviceMonitor port, the client cannot use Recovery Printing
and Parallel Printing.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B click [Next>].
B Click [Network printer], and then click [Next >].
ﬂ Click [Browse].

B Click the computer name you want to use as a print server in the [Browse for
Printer] window.

g Select the printer you want to use, and then click [OK].
[[U Check the location of the selected printer is shown, and then click [Next >].

ﬂ] Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[B Specify whether or not to print a test page, and then click [Finish].
[B Restart the computer.

4 Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows 2000)

ﬂlmportant
O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

O If you print from a print server connected to the printer using the DeskTop
Binder-SmartDeviceMonitor port, the client cannot use Recovery Printing
and Parallel Printing.

ﬂ Quit all applications currently running.

B) insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

E] Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crick Next >].
E Click [Network printer], and then click [Next >].

ﬂ Select the location method from the [Locate Your Printer] screen, and then
click [Next >].

8 Double-click the computer name you want to use as a print server in the
[Shared printers] window.

g Select the printer you want to use, and then click [Next >].
[m The printer driver installation starts.

ﬂ] Click [Next >].
Select the [Yes] check box to configure the printer as default.

B Click [Finish].
Restart the computer to complete installation.

@ Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

ﬂlmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O If you print from a print server connected to the printer using the DeskTop
Binder-SmartDeviceMonitor port, the client cannot use Recovery Printing
and Parallel Printing.

O If you print with a Windows XP or Windows Server 2003 print server, Desk-
Top Binder-SmartDeviceMonitor notification functions may not be possible
for the client.

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crick Next >].

B Click [A network printer, or a printer attached to another computer] and then click
[Next >].

ﬂ Select [Browse for a printer], and then click [Next >].

8 Double-click the computer name you want to use as a print server in the
[Shared printers] window.

g Select the printer you want to use, and then click [Next >].
[m The printer driver installation starts.

B Click [Next>].

Select the [Yes] check box to configure the printer as default.
[B Click [Finish].

Restart the computer to complete installation.
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& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

Installing the PostScript 3 Printer Driver (Windows NT 4.0)

ﬁ*lmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O If you print from a print server connected to the printer using the DeskTop
Binder-SmartDeviceMonitor port, the client cannot use Recovery Printing
and Parallel Printing.

O To print from a Windows NT 4.0 print server, install the printer driver before
you connect the print server to the printer.

O If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.

ﬂ Double-click on "SETUP.EXE" in the downloaded folder.
Add Printer Wizard starts.

ﬂ Click [Network printer server], and then click [Next >].
E) ik Next >].

ﬂ Double-click the computer name you want to use as a print server in the
[Shared printers] window.

B Select the printer you want to use, and then click [Next >].
ﬂ Check the location of the selected printer is shown, and then click [Next >].
ﬂ Change the printer name if you want, and then click [Next >].

8 Specify whether or not to print a test page, and then click [Finish].
Restart the computer to complete installation.

4 Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.
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Using as the NetWare Print Server / Remote
Printer

When using the PostScript 3 Printer Driver

ﬁ*lmportant
O In an IPv6 environment, Netware servers cannot be used.

Follow the procedure below to set up the PostScript 3 printer driver.
ﬂ In the [Printers] or [Printers and Faxes] window, open the printer properties.

B Click the [PostScript] tab.

When using Windows 2000 / XP or Windows NT 4.0, click the [Device Set-
tings] tab, and then proceed to step to clear the check box.

E) Click [Advanced.

ﬂ Clear the [Send CTRL+D before job] and [Send CTRL+D after job] check boxes, and
then click [OK].

B Click [OK] to close the printer properties dialog box.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

ﬂlmportant
O Make sure that machine is connected to the computer's USB ports using the

USB interface cable.

Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.

The printer drivers can be installed from the CD-ROM provided with this ma-
chine.

Windows 98 SE / Me - USB

ﬂlmportant
O Installation via USB is not possible under Windows 95 / 98. Upgrade to Win-
dows 98 SE / Me.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.
ﬂ Turn off the power of the machine.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

8 Turn on the power of the machine.

The plug and play function starts and the [New Hardware Found], [Device Driver
Wizard], or [Add New Hardware Wizard] dialog box appears, depending on the op-
erating system.

O Click [Next >].

B Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

B Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

td 1nsert the CD-ROM into the CD-ROM drive.

8 Specify the location where USB Printing Support is located, and then click
[Next >].

If the CD-ROM drive is D, the source files of USB Printing Support are stored
in the following location:

D:\DRIVERS\RPCS\WIN9X_ME
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E] Check the location, and then click [Next >].
USB Printing Support is installed.

[ click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the "USB001" port is added to the [Printers]
window.

B Click [Next >].

[B Click [Search for the best driver for your device. {Recommended}.], and then click
[Next >].

[B Select the [Specify a location:], check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

[ 1nsert the CD-ROM into the CD-ROM drive.

iE Specify the location where the source files of the printer driver is stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

* PostScript 3
D:\DRIVERS\PS\WIN9X_ME\(Language) \DISK1

[ Check the location, and then click [Next >].
Add Printer Wizard starts.

W click [Finish].

Installation is complete. If installation is successful, the icon of the printer
connected to the "USB001" port is added to the [Printers] window.

& Note
3 When Auto Run starts, click [Exit].
O To disable Auto Run, press the [Shift] key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

O The number after "USB" varies depending on the number of printers con-
nected.

O Itis not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

O After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.

O Install the printer driver from the CD-ROM provided with the printer.



Installing the Printer Driver Using USB

Windows 2000 - USB

ﬂlmportant
O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

ﬂ Check that the power of the printer is off.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B Turn on the power of the machine.

Found New Hardware Wizard starts, and USB Printing Support is installed
automatically.

ﬂ Click [Next >] in the [Found New Hardware Wizard] dialog box.

B Select the [Search for a suitable driver for my device (recommended)] check box,
and then click [Next >].

E Select the [Specify location] check box, and then click [Next >].
 1nsert the CD-ROM into the CD-ROM drive.

8 Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

* PostScript 3
D:ADRIVERS\PS\WIN2K_XP\ (Language) \DISK1

g Check the printer driver location, and then click [OK].
[[D Click [Next >].

B click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the "USB001" port is added to the [Printers]
window.
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& Note
O When Auto Run starts, click [Exit].
O To disable Auto Run, press the left [ Shift] key when inserting the CD-ROM

into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

O The number after “USB” varies depending on the number of printers con-
nected.

Windows XP, Windows Server 2003 - USB

ﬁ*lmportant
O Installing a printer driver requires Administrators permission. Log on using
an account that has Administrators permission.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the "USB" port is added to the [Printers] window.

The printer drivers can be installed from the CD-ROM provided with this ma-
chine.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the CD-ROM provided.

ﬂ Turn off the power of the machine.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

B Turn on the power of the machine.

Found New Hardware Wizard starts, and USB Printing Support is installed
automatically.

ﬂ In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended] ], and then click [Next >].

B To disable Auto Run, press the left [ Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

B Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-
cation.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

* PostScript 3
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

ﬂ Check the printer driver location, and then click [Next >].
3 Eclick [Continue].
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B crick [Finish].

If installation is successful, the icon of the printer connected to the "USB001"
port is added to the [Printers] window.

@ Note

3 If Auto Run starts, click [Cancel], and then [Exit].

O The number after “USB” varies depending on the number of printers con-

nected.

Troubleshooting for using USB

Problems

Solutions

The machine is not automatically rec-
ognized.

Turn off the power of the machine, reconnect the USB
cable, and then turn it on again.

Windows has already configured the
USB settings.

Open Windows' Device Manager, and then, under [Uni-
versal Serial Bus controllers], remove any conflicting de-
vices. Conflicting devices have a yellow [!] or [?] icon by
them. Take care not to accidentally remove required de-
vices. For details, see Windows Help.

& Note

O When using Windows 2000 / XP or Windows Server
2003, an erroneous device is displayed under [USB
Controller] in the [Device Manager] dialog box.
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Printing with Parallel Connection

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

Installing the PostScript 3 Printer Driver (Windows 95 /98 / Me)

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crici Next >].

B Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the machine whose printer driver you want to install,
and then click [Next >].

8 In the [Available ports:] box, click [Printer Port], and then click [Next >].

g Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

[m Specify whether or not to print a test page, and then click [Finish].

ﬂ] Restart the computer to complete installation.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 printer driver (Windows 2000)

ﬂlmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crici Next >].

B Click [Local printer], and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select [LPT1] at the [Printer Port] dialog box, and then click [Next >].
B Select whether or not to share the printer, and then click [Next >].

g Select the name of the machine whose driver you want to install, and then
click [Next >].

[[U Select whether or not you want to print a test page, and then click [Finish].
The printer driver installation starts.

ﬂ] Restart the computer to complete installation if necessary.

& Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows XP, Windows
Server 2003)

ﬂlmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

The printer driver with the selected language will be installed. The English
printer driver is installed when the following language is selected: Cestina,
Magyar, Polski, Portugues, Suomi.

ﬂ Click [PostScript 3 Printer Driver].
Add Printer Wizard starts.

B crici Next >].
B Click [Local printer attached to this computer], and then click [Next >].

ﬂ Select the port you want to use, and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

B Select the name of the machine whose driver you want to install, and then
click [Next >].

B) ciick [Close] to close the [Printer Port] dialog box.
M Click [Next >].
ﬂ] Change the printer name if you want, and then click [Next >].

[B Specify whether or not to print a test page, and then click [Finish].

The printer driver installation starts.

[B Restart the computer to complete installation.

4 Note

O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.
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Installing the PostScript 3 Printer Driver (Windows NT 4.0)

ﬂlmportant
O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O If your operating system is Windows NT4.0, download printer driver for
Windows NT4.0 from the supplier's Web site.

ﬂ Double-click on "SETUP.EXE" in the downloaded folder.
Add Printer Wizard starts.

E select [My Computer], and then click [Next >].

B Select the port you want to use, and then click [Next >].
A dialog box for selecting the printer manufacturer and model name appears.

ﬂ Select the name of the machine whose driver you want to install, and then
click [Next >].

B Change the printer name if you want, and then click [Next >].
Select the [Yes] check box to configure the printer as default.

B Specify whether or not to share the printer, and then click [Next >].

ﬂ Specify whether or not to print a test page, and then click [Finish].
The printer driver installation starts.

B Restart the computer to complete installation if necessary.

& Note
O A user code can be set after the printer driver installation. For information
about user code, see the printer driver Help.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

37



38

Windows Configuration

Printing with Bluetooth Connection

Supported Profiles

< SPP, HCRP

* A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

¢ When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

* Conditions for bidirectional communications
* SPP connection does not support bidirectional communications.
¢ HCRP connection supports bidirectional communications.

< BIP
¢ For BIP connection, a module including PostScript 3 must be installed in
the machine.

* Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

* Only JPEG images that can be printed using BIP.

¢ User codes are disabled for BIP.
You cannot print if print functions are restricted.

* Some printers do not support BIP.

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel inter-
face.

ﬁklmportant

O To install the printer driver under Windows 2000 / XP Professional or Win-
dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrator or Power Users group member.

& Note

O System requirements vary depending on the Bluetooth standard and specifi-
cations. For details, see the manuals provided with each product.

O For information about setting up Bluetooth under other operating systems or
using it with different utilities, see the manuals provided with those operat-
ing systems or utilities.



Printing with Bluetooth Connection

ﬂ Start 3Com Bluetooth Connection Manager.

ﬂ Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

E] On the [Tool] menu, click [COM port].

ﬂ Check that the message "Bluetooth Serial Client (COMXx) " appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

B click [Close].

B On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
8 On the [File] menu, click [Properties].
B Glick the [Ports] tab.

mUnder [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth.

B click [ok).
Close the [Printers] window.

If a dialog box appears while transmitting a print job, reestablish network
connection as follows:

ﬂ Select the printer you want to use in the [Printers and Fax] box.
g Click [Connect].

4 Note

O To always use the same printer, select the [Always use for this connection]
check box.

p Reference

For details, see the manuals provided with the Bluetooth adaptor or com-
puter equipped with Bluetooth.
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Configuring Security Mode Settings

ﬂ Start 3Com Bluetooth Connection Manager.

H On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

B Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.40 “Printing in the Security Mode”

For all other security modes and custom settings, no password is required.
For information about each mode, see the manuals provided with the utility.

O ciick [ok1.
Close the [Security Mode] dialog box.

A Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.40 “Printing in the Security Mode”.

Printing in the Security Mode

ﬂ Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

g The [Authentication] dialog box appears.

B Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label on the back of the ma-
chine. For example, if the serial number is 00A0-001234, the Bluetooth pass-
word is 1234.

ﬂ The print job is sent.

& Note
O The Bluetooth password differs for each machine and cannot be changed.



If a Message Appears during Installation

If a Message Appears during Installation

Message number 58 or 34 indicates the printer driver cannot be installed using
Auto Run. Install the printer driver using [Add Printer] or [Install Printer].

For Windows 95 / 98 / Me, Windows 2000 and Windows NT 4.0:

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
ﬂ Double-click the Add Printer icon.
B Follow the instructions in Add Printer Wizard.

& Note

O If the printer driver is on a CD-ROM, the location of the PostScript 3 printer
driver is either D:\DRIVERS\PS\WIN9X_ME\ (Language) \DISK1 or
D:ADRIVERS\PS\WIN2K_XP\(Language)\DISK1. If the installer starts,
click [Cancel] to quit.

For Windows XP Professional and Windows Server 2003:

ﬂ On the [Start] menu, click [Printers and Faxes].
B Click [Add a printer].
8 Follow the instructions in Add Printer Wizard.

@ Note

O If the printer driver is on a CD-ROM, the location of the PostScript 3 printer
driver is D:\DRIVERS\PS\WIN2K_XP\ (Language) \DISK1. If the install-
er starts, click [Cancel] to quit.

For Windows XP Home Editions:

ﬂ On the [Start] menu, click [Control Panel].

ﬂ Click [Printers and Other Hardware].

8 Click [Printers and Faxes].

ﬂ Click [Install Printer].

B Follow the instructions in Add Printer Wizard.

& Note
O If the printer driver is on a CD-ROM, the location of the PostScript 3 printer
driver is D:\DRIVERS\PS\WIN2K_XP\ (Language) \DISK1. If the install-
er starts, click [Cancel] to quit.
4]
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Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

Set up option settings when bidirectional communications are disabled.

ﬂlmportant

O Under Windows 2000 / XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

O Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] folder. Log on as an Administrators or Pow-
er Users group member.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].

The [Printers] window appears.

g Click the icon of the printer you want to use.
B On the [File] menu, click [Properties].

ﬂ Click the [Accessories] tab.

Under Windows 2000 / XP, Windows Server 2003 and Windows NT 4.0, click
the [Device Settings] tab.

B Select options installed from the [Options] area, and then make the neces-
sary settings.

Under Windows 2000 / XP, Windows Server 2003 and Windows NT 4.0, click
the [Installable Options] area.

B Click [Apply], and then click [OK] to close the printer properties dialog box.

/O Reference

For details about making option settings for the printer, see p.61 “Setting
Up Options”.



Setting Up the Printer Driver

Setting Up the Printer Driver

Windows 95 /98 / Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making printer default settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

ﬁ*lmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

8 On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].
H crick [ok.

& Note

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

p Reference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95/98/Me.

) on the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].
The printer properties dialog box appears.
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B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

p Reference
For details, see the printer driver Help.

Windows 2000 - Accessing the Printer Properties

Making printer default settings - the printer properties

iﬁklmportant

O To change the printer default settings including option configuration settings, log
on using an account that has Manage Printers permission. Members of the Admin-
istrators and Power Users groups have Manage Printers permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O Do not make a setting for [Form to Tray Assignment].

A Reference
For details, see the printer driver Help.
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Making printer default settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

B On the [File] menu, click [Print..].
The [Print] dialog box appears.

g Select the printer you want to use in the [Select Printer] list.

B On the [Preferences] tab, make the necessary settings, and then click [Print]
to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.
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A Reference
For details, see the printer driver Help.

Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making printer default settings - the printer properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

g Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O Do not make a setting for [Form to Tray Assignment].

p Reference
For details, see the printer driver Help.

Making printer default settings - Printing Preferences

iﬁklmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

I] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference u

For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

ﬂ On the [File] menu, click [Print...].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.

B On the [Preference] tab, make the necessary settings, and then click [Print] to
start printing.

4 Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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Windows NT 4.0 - Accessing the Printer Properties

Making printer default settings - the printer properties

ﬂlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

O Do not make a setting for [Form to Tray Assignment].

p Reference
For details, see the printer driver Help.

Making printer default settings - Default

ﬁkl mportant
O To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

p Reference
For details, see the printer driver Help.

Making printer settings from an application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

B On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Proper-
ties].

The printer properties dialog box appears.
B Make the necessary settings, and then click [OK].
O crick [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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S
2. MacOS Configuration

MacOS

This section explains how to configure a Mac OS to use EtherTalk and USB.

The following explains how to configure Mac OS 9.1. If you are not using Mac
0S 9.1, see the manual of the Mac OS you are using for details

i@klmportant
O For Mac OS 8.6 and higher. (Mac OS X Classic environment is supported.)

@ Note

O The PostScript 3 printer driver is stored in the following folder on the CD-
ROM.

Mac OS 8 and 9: PS Driver: (language) :Diskl

Installing the PostScript 3 Printer Driver and PPD File

It is necessary to install a printer driver and PostScript Printer Description (PPD)
files to print from a Mac OS.

Follow the procedure below to install a printer driver and a PPD file into a Mac
OS using Mac OS 8.6 and higher.

PostScript 3 Printer Driver

) insert the CD-ROM into the CD-ROM drive.

ﬂ Double-click the CD-ROM drive icon.

8 Double-click the [Mac OS 8 and 9] folder.

O bouble-click the [PS Driver] folder.

ﬂ Double-click the folder of the language you use.

B Open [Disk1], and then double-click the installer icon.

ﬂ Follow the instructions on the screen.
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PPD Files

ﬂ Double-click the CD-ROM drive icon.

ﬂ Double-click the [Mac OS 8 and 9] folder.

E) Double-click the [Printer Descriptions] folder.

ﬂ Double-click the folder of the language you are using.
B open the [DISK1] folder.

E Drag the PPD file and the plugin file into [Printer Descriptions] in [Extensions]
under [System Folder].

ﬂ Restart the Mac OS.

Setting Up PPD Files

iﬁklmportant
O Make sure that the printers are connected to an AppleTalk network before
performing the following procedure.

ﬂ On the [Apple] menu, click [Chooser].
ﬂ Click the Adobe PS icon.

B In the [Select a PostScript Printer:] list, click the name of the printer you want
to use.

ﬂ Click [Create].

B Click the printer you want to use, and then click [Setup].

A PPD file is set up and the Adobe PS icon appears at the left of the printer
name in the list. Follow the procedure on p.53 “Setting Up Options” to make
option settings; otherwise close the [Chooser] dialog box.



MacOS

Setting Up Options

ﬂ On the [Apple] menu, click [Chooser].
ﬂ Click the Adobe PS icon.

B In the [Select a PostScript Printer:] list, click the name of the printer you want
to use, and then click [Setup].

O click [Configure].
A list of options appears.

ﬂ Select the option you want to set up, and then select an appropriate setting
for it.

(3 ciick [ok).
The list of options closes.
U crick fox.
The [Chooser] dialog box appears.

8 Close the [Chooser] dialog box.

& Note

O If the option you want to select is not displayed, PPD files may not be set
up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.

Installing Adobe Type Manager

ﬂlmportant
O Quit all applications currently running before installation. Install ATM after
you restart the computer.

ﬂ Start a Mac OS.

ﬂ Insert the CD-ROM into the CD-ROM drive.
B bouble-click the CD-ROM drive icon.

ﬂ Double-click the [Mac OS 8 and 9] folder.

B Double-click the [ATM] folder.

B Double-click the ATM 4.6.2 installer icon.

ﬂ Follow the instructions on the screen.
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8 When the procedure is complete, restart the computer. ATM will be com-
pletely installed only after restarting.

g On the [Apple] menu, open [Control Panel], and then click [~ATM].
[m The ATM control panel opens.

@ Note

O For details about installation, see the operating instructions in the ATM
folder.

Installing Screen fonts

Follow the procedure below to install screen fonts.

The screen fonts described below can be found in the [Fonts] folder on the CD-
ROM.

ﬂ Start a Mac OS.

B insert the CD-ROM into the CD-ROM drive.
The CD-ROM drive icon appears.

B Double-click the CD-ROM drive icon.
The contents of the CD-ROM appear.

ﬂ Double-click the [Mac OS 8 and 9] folder.
B bouble-click the [Fonts] folder.
[ bouble-click the [Screen font] folder.

d Double-click the [TrueType] or [Typet] folder.
Select the font type you want to use.

8 Copy the fonts you want to install in [System Folder].
A confirmation message appears.

B crick [ok).
The fonts are installed.

[[U Restart the Mac OS.
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Changing to EtherTalk

Follow the procedure below to configure to a Mac OS to use EtherTalk.

ﬂ Open [Control Panel], and then double-click the AppleTalk icon.
g On the [Connect via:] pop-up menu, click [Ethernet].

8 If you change zones, select a name on the [Current zone:] pop-up menu.
ﬂ Close the AppleTalk control panel.

B Restart the computer.

4 Note

O The procedures used to configure Mac OS may vary depending on the Mac
OS version. The following describes how to configure Mac OS 9.1. If you
are using a different version of Mac OS, use the following procedures as a
reference and see the manuals for your Mac OS version.

O Confirm the Connection to the Printer with TCP/IP

A Reference
For information about installing applications required for EtherTalk, see
the Mac OS manuals.
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Mac OS X

This section explains how to configure a Mac OS X to use EtherTalk, USB and
TCP/1P.

Follow the procedure below to configure Mac OS X 10.3.8. If you are not using
Mac OS X 10.3.8, see the manual of the Mac OS X you are using for details.

ﬁklmportant
O For Mac OS X 10.1 or higher.

& Note
O The PPD files are stored in the following folder on the CD-ROM.

Mac OS X: PPD Installer

Installing the PPD Files

Follow the procedure below to install a PPD file to print from Mac OS X.

ﬁ*lmportant
O You need an administrator name and a password (phrase). For details, con-
sult your network administrator.

0 insert the CD-ROM into the CD-ROM drive.
B Double-click the CD-ROM drive icon.

E) Double-click the [Mac 0S X] folder.

ﬂ Double-click the [MacOSX PPD Installer] folder.
B Double-click the installer icon.

B Follow the instructions on the screen.
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Setting Up the PPD File

ﬂ Start Printer Setup Ultility.
B click [Add].

< Mac OS X 10.4 or later

Click a printer that has "AppleTalk" indicated in the "Connection" column.
If the zone is set, click [More Printers...], and then select the zone from the
second pop-up menu.

% Other Mac OS X
Click [AppleTalk] on the first pop-up menu.
If the zone is set, select the zone from the second pop-up menu.

8 Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.

Under Mac OS X 10.4 or later, you are using from the [Print Using] popup
menu.

A list of printer types appears.
ﬂ Select the PPD file for the model you are using, and then click [Add].
B Quit Printer Setup Utility.

Setting Up Options

ﬂ Start System Preferences.
ﬂ Click [Print & Fax].

B In the [Printer] list, click the name of the printer you want to use, and then
click [Printer Setup...].

ﬂ Select the option you want to set up, and then select an appropriate setting
for it.

B Click [Apply Changes].

& Note

O If the option you want to select is not displayed, PPD files may not be set
up correctly. To complete the setup, check the name of the PPD file dis-
played in the dialog box.

S/
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Using USB Interface

Follow the procedure below to set up USB connection.
ﬂ Start Printer Setup Utility.
B crick [Add].

% Mac OS X 10.4 or later
Click a printer that has "USB" indicated in the "Connection" column.

«» Other Mac OS X
Click [USB] on the pop-up menu.
The connected printer appears.

B Select the printer, and then select its manufacturer from the [Printer Model:]
pop-up menu.
Under Mac OS X 10.4 or later, you are using from the [Print Using] pop-up menu.
A list of printer types appears.

ﬂ Select the connected printer from the list of printer models, and then click
[Add].

B Quit Printer Setup Utility.

& Note

O When printing with a USB connection to a Macintosh computer, printer
language does not change automatically. Use the control panel on this
printer to change printer language to [Auto Detect] or [PS] before printing.

O USB2.0 can be used only with Mac OS X 10.3.3 or higher.

Using Bonjour (Rendezvous)

Follow the procedure below to print using Bonjour (Rendezvous) under Mac OS
X10.2.3 or higher. Ethernet, wireless LAN and IEEE 1394 (IP over 1394) connec-
tions can also be used.

ﬂ Start Printer Setup Utility.
B click [Add).

< Mac OS X 10.4 or later

Click a printer that has "Bonjour” indicated in the "Connection" column.
If the zone is set, click [More Printers...], and then select the zone from the
second pop-up menu.

% Other Mac OS X
Click [Rendezvous] on the pop-up menu.
If the zone is set, select the zone from the second pop-up menu.



Mac OS X

B Select the name of the connected printer from the list of printer models, and
then click [Add].

Under Mac OS X 10.4 or later, Installable Options window appears. Select the
option you want to set up, and then select an appropriate setting for it, and
then [Continue].

ﬂ Quit Printer Setup Utility.

& Note

O When printing with a Rendezvous connection to a Macintosh computer,
printer language does not change automatically. Use the control panel on
this printer to change printer language to [Auto Detect] or [PS] before print-
ing.

Changing to EtherTalk
Follow the procedure below to configure a Mac OS X to use EtherTalk.

ﬂlmportant
O You need an administrator name and a password (phrase). For details, con-
sult your network administrator

ﬂ Open [System Preference], and then click the Network icon.
B Click [Built-in Ethernet] in the [Show:] list box.

E] Click the [AppleTalk] tab.

O select the [Make AppleTalk Active] check box.

B To change AppleTalk zones, select a name from the [AppleTalk Zone:] pop-up
menu.

B When the settings are made, click [Apple Now].

p Reference

For information about installing applications required for EtherTalk, see
the Mac OS manuals.
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Configuring the Printer

Use the control panel to enable AppleTalk. (The default is active.)
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Setting Up Options

To use installed options correctly, first set up the printer driver. If the options are
not recognized, you cannot use them, even though they are physically installed.
The procedure to set up a printer driver varies depending on the operating sys-
tem.

< Windows

iiklmportant

O If your system is Windows 2000, Windows XP Professional, or Windows
Server 2003, changing printer driver settings requires Manage Printers
permission. Members of Administrators and Power Users groups have
Manage Printers permission by default. When you change printer driver
settings, log on with an account that has Manage Printers permission.

O If your system is Windows NT 4.0, changing printer driver settings re-
quires Full Control access permission. Members of Administrators, Server
Operators, Print Operators, and Power Users groups have Full Control
permission by default. When you change printer driver settings, log on
with an account that has Full Control permission.

O If you are using Adobe Page Maker 6.0, 6.5, or 7.0 with Windows 95 / 98 /
Me / 2000 / XP, Windows Server 2003, or Windows NT 4.0, you have to
set up options in the Adobe PageMaker's print dialog box.

You can set up any of the options using the following tabs:

Windows 95 / 98 / Me [Options] on the [Accessories] tab.

Windows 2000 / XP, Windows Server | [Installable Options] on the [Device Settings] tab.

2003

Windows NT 4.0 [Installable Options] on the [Device Settings] tab in the

Properties dialog box.

Mac OS For ethernet, [Chooser] on the Apple Menu. For USB,
[Change Setup] from the [Printing] menu to open the
Desktop printer.

Mac OS X [Printer Setup...] in [Print & Fax] to open the System Pref-
erences.

@ Note

O To set up options, access the printer driver from Windows. You cannot set
up options if you access the printer driver from an application.
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+ Mac OS

ﬁlmportant
O If you are using Mac OS X, this function cannot be used.
You can set up all options using the [Chooser] dialog box.

A Reference
See p.42 “Making Option Settings for the Printer”, p.53 “Setting Up Options”
or p.57 “Setting Up Options” for the installation method appropriate to your
printing environment.



Printing a Document

Printing a Document

This documentation describes the specific printer functions and menus that are
added by installing the PPD file. For more information about the functions and
menus of the Windows 95 / 98 / Me PostScript printer driver, see the printer
driver's Help.

ﬂlmportant
O On a Macintosh, Mac OS 8.6 or higher (Mac OS X Classic environment is sup-
ported.), or Mac OS X 10.1 or higher is required.

& Note
O If you are using Mac OS X 10.2.x or higher, the Job Type function can be used.
O “Mac OS X” in the tables below refers to Mac OS X 10.2.3. Depending on the

version, [Features x] is displayed as [Set x] (x is a number). Make adjustments
according to the version you use.

Job Type

Use this to select the type of print job.
The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Job Type:] on the [Setup] tab.

You can select the following items:

«» Normal Print
Select this for normal printing. The print job starts immediately after the print
command is given.

& Note

O Under Windows 95 / 98 / Me, if you want to use an User ID, click the [De-
tails...] button.
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User Code

Use this to set a user code for print logging.

Enter a user code using up to eight digits. A user code identifies a group of users
and allows you to check the number of sheets printed under each code with
SmartDeviceMonitor for Admin.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [User Code] on the [Statistics] tab.

Windows 2000 / XP, Windows Server 2003 | [User ID:] on the [Job Log] tab in the Printing Preferences
dialog box.

Windows NT 4.0 [User ID:] on the [Job Log] tab in the Document Defaults
dialog box.

Mac OS Select the [Enable User Code] check box, and then enter a
user code in the [User Code] box on [Job Log] in the print
dialog box.

Mac OS X Select the [Enable User Code] check box, and then enter a
user code in the [User Code] box on [Job Log] in the print
dialog box.

A Reference

For details about using SmartDeviceMonitor for Admin, see Help.

Paper Selection

Use this to select the media type and input tray.

ﬁ*lmportant
O This function is for Windows 95 / 98 / Me only.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Paper Selection:] on the [Paper] tab.

A Reference
For details about the Paper Selection. See the printer driver's Help.
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Paper Size

Use this to select the size of paper you want to use.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me

[Size:] on the [Paper] tab.

Windows 2000 / XP, Windows Server
2003

[Paper Size:] on [Paper/Output] on [Document Options] on
[Advanced...] on the [Paper/Quality] tab in the Printing Pref-
erence dialog box.

Windows NT 4.0 [Paper Size:] on the [Page Setup] tab in the Document De-
faults dialog box.
Mac OS [Paper:] on the [Page Attributes] tab in the Page Setup dialog box.
Mac OS X [Paper Size:] in the Page Setup dialog box.
A Reference
For details about the paper sizes supported by this machine, see General Set-
tings Guide.
Fit to Paper

When the size of the document and paper size differ, set whether or not to print

according to paper size.

Windows 95 / 98 / Me

[Fit to Print Size:] on the [Paper] tab.

Windows 2000 / XP, Windows Server
2003

[Fit to Paper] on [Printer Features] on [Document Options] on
[Advanced...] on the [Paper/Quality] tab in the Printing Pref-
erences dialog box.

Windows NT 4.0 [Fit to Paper] on [Document Options] on the [Advanced] tab
in the Document Defaults dialog box.

Mac OS [Fit to Paper:] on [Printer Specific Options] in the print dialog box.

Mac OS X [Fit to Paper:] on the [Features x] tab on [Printer Features] in

the print dialog box.

+ Prompt User

Print is performed with the size of document to be printed unchanged.

+ Nearest Size and Scale

The printer selects the paper size that is closest to the size specified by the file.
If the paper size is smaller than the selected paper size, the driver reduces the

print size.

If the paper size is larger than the size of document to be printed, print is not

to fit the paper size.

% Nearest Size and Crop

The printer selects the paper size that is closest to the size specified by the file,

but the print image is not reduced or enlarged to fit the selected paper size.
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Input Slot

Use this to select the paper sources.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me

[Input Tray:] on the [Paper] tab.

Windows 2000 / XP, Windows Server
2003

[Paper Source] on the [Paper/Quality] tab in the Printing
Preferences dialog box.

Windows NT 4.0 [Paper Source] on the [Page Setup] tab in the Document
Defaults dialog box.
Mac OS [Paper Source:] on [General] in the print dialog box.
Mac OS X [Paper Feed] in the print dialog box.
A Reference

For details about the paper sources, see Printer Reference.

Resolution

Use this to set the resolution types.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me

[Resolution] on the [Print Quality] tab.

p Reference

For more information about the resolution types, see Printer Reference.
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Orientation Override

Use this to set the paper orientation.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me

[Orientation Override:] on the [Setup] tab.

Windows 2000 / XP, Windows Server
2003

[Orientation Override] on [Printer Features] on [Document Op-
tions] on [Advanced...] on the [Paper/Quality] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Orientation Override] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Mac OS [Orientation Override] on [Printer Specific Options] in the
print dialog box.

Mac OS X [Orientation Override] on the [Features x] tab on [Printer Fea-

tures] in the print dialog box.

You can select the following items:

o Off
¢ Landscape
e Portrait

@ Note

O Under Windows 95/98/Me, select the [Orientation Override] check box, and

then select [Landscape] or [Portrait] in the [Orientation:] list.

Print Mode

Use this function to reduce the amount of toner used when printing.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me

[Toner Saving] on the [Print Quality] tab.

Windows 2000 / XP, Windows Serv-
er 2003

[Print Mode] on [Printer Features] on [Document Options] on
[Advanced...] on the [Paper/Quality] tab in the Printing Pref-
erences dialog box.

Windows NT 4.0 [Print Mode] on [Printer Features] on [Document Options] on
the [Advanced] tab in the Document Defaults dialog box.
Mac OS [Print Mode] on [Printer Specific Options] in the print dialog
box.
Mac OS X [Print Mode] on the [Features x] tab on [Printer Features] in
the print dialog box.
A Reference

For details about this function, see Printer Reference.
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Duplex Printing

Use this function to select duplex printing.

ﬂlmportant

O To use this function, the optional duplex unit must be installed on the ma-

chine.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me

[Duplex:] on the [Setup] tab.

Windows 2000 / XP, Windows Server

[Print on Both Sides] on the [Layout] tab in the Printing

2003 Preferences dialog box.

Windows NT 4.0 [Print on Both Sides (Duplex Printing)] on the [Page Setup] tab
in the Document Defaults dialog box.

Mac OS [Print on Both Sides] on [Layout] in the print dialog box.

Mac OS X e 10.3 or higher

The [Two Sided] check box on [Layout] in the print dia-
log box.

e Other Mac OS X
The [Print on both Sides] check box on [Duplex] in the
print dialog box.

The following items may vary depending on the operating system you are using.

Windows 95/98 / Me

“ Off
Disables Duplex Printing.

% Open to Left

Prints output so that you can open it to the left.

% Open to Top

Prints output so that you can open it to the top.
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Windows 2000 / XP, Windows Server 2003, Mac OS

< None
Disables Duplex Printing.

« Flip on Short Edge
Prints output so that you can open it to the short edge when bound along the
short edge.

+ Flip on Long Edge
Prints output so that you can open it to the long edge when bound along the
long edge.

@ Note

O If you are using a Mac OS, click to select the button that means “Flip on Long
Edge” or “Flip on Short Edge”.

Windows NT 4.0

% None
Disables Duplex Printing.

< Short Side

Prints output so that you can open it to the short edge when bound along the
short edge.

% Long Side
Prints output so that you can open it to the long edge when bound along the
long edge.

Mac OS X

The following functions are selectable under Mac OS X 10.3 or higher (for Mac
OS X 10.2 or earlier, see p.69 “Windows 2000 / XP, Windows Server 2003, Mac
0S”):

“ Off
Disables Duplex Printing.

% Long-edged binding
Prints output so that you can open it to the long edge when bound along the
long edge.

% Short-edged binding
Prints output so that you can open it to the short edge when bound along the
short edge.
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Collate

Use this function to enable collation. With this feature, the machine can efficient-
ly print collated sets of multiple-page documents.

ﬂlmportant
O If you are using Windows 2000, Windows XP, Mac OS or Mac OS X, make
sure that the following check boxes have not been selected.

e Windows 2000
The [Collate] check box on [Copies] on [Printer Features] on [Advanced...] on
the [Paper/ Quality] tab in the Printing Preferences dialog box.

e Windows XP
The [Collate] check box on [Copies] on [Paper/Output] on [Advanced...] on the
[Paper/ Quality] tab in the Printing Preferences dialog box.

¢ Mac OS
The [Collate] check box in the print dialog box.

¢ MacOS X
The [Collate] check box on [Copies & Pages] in the printer dialog box.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Collate:]Jon the [Setup] tab.

Windows 2000, Windows XP [Collate:] on [Printer Features] on [Document Options] on [Ad-
vanced...] on the [Paper/Quality] tab in the Printing Prefer-
ences dialog box.

Windows NT 4.0 [Collate:] on [Printer Features] on [Document Options] on the
[Advanced] tab in the Document Defaults dialog box.

Mac OS [Collate:] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Collate:] on the [Features X] tab on [Printer Features] in the
printer dialog box.

Paper Type

Use this to select the paper type.
The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Type:] on the [Paper] tab.

Windows 2000 / XP, Windows Serv- | [Media:] on the [Paper/Quality] tab in the Printing Prefer-

er 2003 ence dialog box.

Windows NT 4.0 [Paper/Output] on the [Advanced] tab in the Document De-
faults dialog box.

Mac OS [Paper Type:] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Paper Type] on the [Features x] tab on [Printer Features] in
the print dialog box.
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p Reference

For details about the media type supported by this machine, see General Set-
tings Guide.

Destination

Use this to select the destination tray.
The following table shows where you can select this function.

Windows 95 / 98 / Me [Output Tray:] in the [Paper] tab.

Windows 2000 / XP, Windows Serv- | [Destination] in [Printer Features] on [Document Options] on
er 2003 [Advanced...] on the [Paper/Quality] or [Layout] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Destination] in [Printer Features] on [Document Options] on
the [Advanced] tab in the Document Defaults dialog box.
Mac OS [Destination] in [Printer Specific Options] in the print dialog
box.
Mac OS X [Destination]on the [Features x] tab in [Printer Features] in
the print dialog box.
K Reference

For details about the destination tray supported by this machine, see General
Settings Guide.

Watermark

Set the Watermark function.

Windows 2000 / XP, Windows Server | [Watermark:] on [Printer Features] on [Document Options] on
2003 [Advanced...] on the [Paper/Quality] or [Layout] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Watermark:] on [Printer Features] on [Document Options] on
the [Advanced] tab in the Document Defaults dialog box.

@ Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS
X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.
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Watermark Text

Select the Watermark Text type.

Windows 2000 / XP, Windows Server | [Watermark Text] on [Printer Features] on [Document Options]
2003 on [Advanced...] on the [Paper/Quality] or [Layout] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Watermark Text] on [Printer Features] on [Document Options]
on the [Advanced] tab in the Document Defaults dialog
box.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS
X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.

Watermark Font

Select the Watermark Font type.

Windows 2000 / XP, Windows Server | [Watermark Font] on [Printer Features] on [Document Options]
2003 on [Advanced...] on the [Paper/Quality] or [Layout] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Watermark Font] on [Printer Features] on [Document Options]
on the [Advanced] tab in the Document Defaults dialog
box.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS
X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.

Watermark Size

Select the Watermark Size size.

Windows 2000 / XP, Windows Server | [Watermark Size] on [Printer Features] on [Document Options]
2003 on [Advanced...] on the [Paper/Quality] or [Layout] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Watermark Size] on [Printer Features] on [Document Options]
on the [Advanced] tab in the Document Defaults dialog
box.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS
X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.
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Watermark Angle

Select the Watermark angle.

ﬂlmportant
O This item is only for portrait, not for landscape.

Windows 2000 / XP, Windows Server | [Watermark Angle] on [Printer Features] on [Document Op-
2003 tions] on [Advanced...] on the [Paper/Quality] or [Layout] tab
in the Printing Preferences dialog box.

Windows NT 4.0 [Watermark Angle] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS
X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.

Watermark Style

Select the Watermark style.

Windows 2000 / XP, Windows Server | [Watermark Style] on [Printer Features] on [Document Op-
2003 tions] on [Advanced...] on the [Paper/Quality] or [Layout] tab
in the Printing Preferences dialog box.

Windows NT 4.0 [Watermark Style] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

& Note

O When using this function under Windows 95 / 98 / Me, Mac OS, or Mac OS
X, see the printer driver Help. The following explains the procedure for Win-
dows 2000 / XP, Windows Server 2003, and Windows NT 4.0.
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Dithering

Use this to set the Image Rendering mode.

The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me

[Dithering:] on the [Print Quality] tab.

Windows 2000 / XP, Windows Server
2003

[Dithering:] on [Printer Features] on [Document Options] on
[Advanced...] on the [Paper/Quality] or [Layout] tab in the
Printing Preferences dialog box.

Windows NT 4.0 [Dithering:] on [Printer Features] on [Document Options] on
the [Advanced] tab in the Document Defaults dialog box.

Mac OS [Dithering:] on [Printer Specific Options] in the print dialog
box.

Mac OS X [Dithering:] on the [Features x] tab on [Printer Features] in

the print dialog box.

You can select the following items:

«» Auto

Use this setting to configure the best dithering method automatically depend-
ing on the appearance of the document to be printed.

% Photographic

Performs dithering using an appropriate pattern for photographs.

« Text

Performs dithering using an appropriate pattern for text.

« User Setting

Use this setting to print images set in half tone in your application.
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Image Smoothing

Use this to select the image smoothing type.
The following table shows the tabs or menus where you can select this function.

Windows 95 / 98 / Me [Image Smoothing:] on the [Print Quality] tab.

Windows 2000 / XP, Windows Serv- | [Image Smoothing:] on [Printer Features] on [Document Op-

er 2003 tions] on [Advanced...] on the [Paper/Quality] or [Layout]tab
in the Printing Preferences dialog box.

Windows NT 4.0 [Image Smoothing:] on [Printer Features] on [Document Op-
tions] on the [Advanced] tab in the Document Defaults di-
alog box.

Mac OS [Image Smoothing:] on [Printer Specific Options] in the print
dialog box.

Mac OS X [Image Smoothing:] on the [Features x] tab on [Printer Fea-

tures] in the print dialog box.

< Off

Disables image smoothing.
< On

Performs image smoothing unconditionally.
< Auto

Performs image smoothing automatically for images that have a resolution
less than 25% of supported printer resolution.

% Less than 90 ppi - Less than 300 ppi
Performs image smoothing only when the image has an image resolution
(pixels per inch) less than the respective value you have selected in the list.

& Note
O When [Auto] is selected, data processing may take a long time.

O When [Image Smoothing:] is used for a mask image, this function may have an
undesired effect on the print result.
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e
4. Printer Utility for Mac

By using Printer Utility for Mac, you can download fonts, change the name of
the printer and so on.

Installing Printer Utility for Mac

Follow these steps to install Printer Utility for Mac on the machine.

i@klmportant
O If a Macintosh and printer are connected by USB, you cannot use Printer Util-
ity for Mac.

ﬂ Start the Mac OS.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The CD-ROM icon appears.

B Double-click the CD-ROM icon.
The contents of the CD-ROM appear.

O bouble-click the [Mac 0S] folder.
Under Mac OS X, double-click the [Mac OS X] folder.

ﬂ Double-click the [PS Utility] folder on the CD-ROM, and then drag the [Print-
er Utility for Mac] file, and then drop it into the Macintosh hard disk.

B Drag the CD-ROM icon and drop it into [Trash] to eject the CD-ROM.
Printer Utility for Mac is installed.

& Note

O Printer Utility for Mac is included on the CD-ROM labeled “Printer Driv-
ers and Utilities”.

O Printer Utility for Mac requires Mac OS 8.1 or higher. (Mac OS X Classic
environment is supported.)

O Printer Utility for Mac cannot use Mac OS X (native mode).
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Starting Printer Utility for Mac

The following instructions describe how to start Printer Utility for Mac.

Mac OS

ﬂlmportant
O Before starting Printer Utility for Mac, make sure the printer is selected in
[Chooser] on the Apple menu.

ﬂ Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.

B click [oK.
Printer Utility for Mac will take a few seconds to start.

Mac OS X

ﬂ Double-click the Printer Utility for Mac icon.
The [Printer Utility for Mac] dialog box appears.
B click [ok).

B In the [Available Printers:] box, select the printer you want to use.
If you change zones, select a name from [Available Network Zones:].

Click [Choose Printer...] on the Printer Utility for Mac menu if you want to
change the printer.

ﬂ Select the printer you want to use.
Printer Utility for Mac will take a few seconds to start.

B click [choose].



Printer Utility for Mac Functions

Printer Utility for Mac Functions

Printer Utility for Mac functions are described below.

< File menu

[Download PS Fonts...]
Download fonts (PostScript Type 1) to the printer. See p.80 “Downloading
PS Fonts”.

[Display Printer's Fonts...]
Display and delete the fonts in printer memory. See p.81 “Displaying
Printer's Fonts”.

[Initialize Printer's Disk...]

This function cannot be used.

[Page Setup...]

Set up the paper size to print “Printer Font Catalog” and “Printer Font
Sample”. See p.81 “Page Setup”.

[Print Fonts Catalog...]
Print the names of available fonts. See p.82 “Printing Fonts Catalog”.

[Print Fonts Sample...]
Print a sample of fonts. See p.82 “Printing Fonts Sample”.

[Rename Printer...]

Change the printer's name when viewed via Appletalk. See p.82 “Renam-
ing the Printer”.

[Restart Printer]

Restart the printer. See p.83 “Restarting the Printer”.

+ Utility menu

[Download PostScript File...]
Download a PostScript file. See p.83 “Downloading PostScript Files”Post-
Script.

[Select Zone...]

Change the zone to which the printer belongs to via Appletalk. See p.84
“Selecting the Zone”.

[Display Printer Status...]
Display the status of the printer. See p.85 “Displaying the Printer Status”.

[Launch Dialogue Console...]
Create and edit a PostScript file, and then download it to the printer. See
p-85 “Launching the Dialogue Console”.
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Downloading PS Fonts

You can download the PS fonts to the printer's memory.

ﬂlmportant

O The following procedures to download the fonts assume that you are a sys-
tem administrator. If you are not, be sure to consult your system administra-
tor.

O If the printer restarts, all the printer settings return to their defaults.
O Confirm that a Mac OS and the printer are connected with Appletalk.

O During the download, do not turn off the power switch, operate the panel or
open or close the cover.

ﬂ Select [Download PS Fonts...] on the [File] menu.

B Click [Add to list].
The dialog box to select fonts appears.

B Click to select the desired font files, and then click [Open].
The list of selectable font names appears.

ﬂ After adding all the fonts you want to download, click [OK].
Under Mac OS X, click [choose].
The dialog box of selected fonts to download appears.

B ciick [pownload].
The fonts begin to download, and the download status is shown.

ﬂ When the completion message appears, click [OK].
U click [cancel].

@ Note
O Some fonts cannot be downloaded.

O Before downloading, read the documentation about the fonts you want to
use.
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Displaying Printer's Fonts

You can display the available fonts currently downloaded to the printer. Fonts
in the printer's memory can be displayed.

ﬂ Select [Display Printer's Fonts...] on the [File] menu.
A dialog box appears.

ﬂ Select [Printer's memory].
B click [ok).

& Note
O The fonts displayed in italics are the default fonts.

Deleting Fonts

You can delete fonts from the printer's memory.

i@klmportant
O You cannot delete the fonts displayed in italic.

ﬂ Select [Display Printer's fonts] on the [File] menu.
A dialog box appears.

ﬂ Select [Printer's memory].
B Select the fonts you want to delete.

O click [pelete].
A confirmation message appears.

ﬂ Confirm the fonts you want to delete and the printer name from which you
want to delete the fonts.

[3 ciick [Continue], and then click [OK].
U crick [ok).

Page Setup

You can set the paper size on which to print “Print Fonts Catalogue” and “Prints
Fonts Sample”.

ﬂ Select [Page Setup...] on the [File] menu.

g Choose the paper size.
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Printing Fonts Catalog

Print the names of fonts available on the printer.
ﬂ Select [Print Fonts Catalogue] on the [File] menu.
B crick print].

& Note
O The paper selected under [Page Setup] is used.

Printing Fonts Sample

You can print samples of fonts downloaded to the memory.
I] Select [Print Fonts Sample...] on the [File] menu.
B crick print].

& Note
O Print by using the paper selected on [Page Setup].

Renaming the Printer

You can change the printer name displayed under Appletalk. If you connect sev-
eral printers on the network, assign different names so you can identify them. If
several printers have the same name, a digit appears next to the printer name in
[Chooser].

i@klmportant
O You can enter up to 31 digits and letters.

LR YA OV A Ve II@// “” 7
= ~
4 7 4 4

O Do not use symbols, for example

Mac OS

K On the [File] menu, click [Rename Printer..].
B In the [New Name:] filed enter a new name.

E) click [Rename].
The printer name is changed.

O click [oK].
B On the Apple menu, click [Chooser].
(3 Click the [AdobePS] icon.
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ﬂ Select the printer whose name you changed, and then close the [Chooser] di-
alog box.

If there are several Appletalk zones, select the zone the machine belongs to.

Mac OS X

ﬂ On the [File] menu, click [Rename Printer...].
ﬂ In the [New name:] filed enter a new name.

B Click [Rename].
The printer name is changed.

O cick [oK].
B On the [Printer Utility for Mac] menu, click [Choose Printer...].

B In the [Available Network Zones:] list, select the zone for the Macintosh in use.

ﬂ In the [Available Printers:] list, select the printer whose name you changed,
and then click [Choose].

Restarting the Printer

You can restart the printer.
KD select [Restart Printer] on the [File] menu.

ﬂ Confirm the message that appears on the screen, and then click [Restart].
The printer restarts.
The fonts that you downloaded in the printer's memory will be deleted.
If the printer restarts, all the printer settings return to their defaults.

Downloading PostScript Files

You can download a Postscript file to the printer.
I] Select [Download PostScript File...] on the [Utility] menu.

ﬂ Select the file name to download and click the file name, and then click
[Open].

8 Type the log file name, and then click [Save...].
The selected file is downloaded.
Errors are recorded in the log file.
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Selecting the Zone

You can change the zone to which the printer belongs under Appletalk.

ﬂlmportant
O Confirm that a Macintosh and printer are connected with Appletalk.

Mac OS

K on the [utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

g Select the zone in which you want to locate the printer, and then click
[Change].

A confirmation message appears.

E] click [Continue].
A confirmation message appears.

O click [oK].

B On the Apple menu, click [Chooser].

[ rick the [AdobePs] icon.

ﬂ In the [Appletalk zone:] list, select the zone you changed.

8 In the [Select a PostScript Printer:] list, select the printer you want to use.

g Close the [Chooser] dialog box.

Mac OS X

K on the [utility] menu, click [Select Zone...].
The zone to which the printer belongs and the available zone list appear.

g Select the zone which you want to locate the printer in, and then click
[Change].

A confirmation message appears.

E] click [continue].
A confirmation message appears.

O click [oK].
B On the [Printer Utility for Mac] menu, click [Choose Printer...].

B In the [Available Network Zones:] list, select the zone you changed.



Printer Utility for Mac Functions

ﬂ In the [Available Printers:] list, select the model of printer in use, and then
click [Choose].

Displaying the Printer Status

You can display and confirm the current status of the printer.

I] Select [Display Printer Status...] on the [Utility] menu.
The current status of the printer appears.

ﬂ Confirm the current status of the printer.

You can confirm the memory capacity. You can also confirm the zone to
which the printer belongs to.

B click [ok).

Launching the Dialogue Console

You can create and edit a PostScript file for printing, and then download it to the
printer.

ﬁklmportant
O “Launch Dialogue Console” is recommended for users with an understand-
ing of PostScript.

O Do not download any file other than PostScript files to the printer.
O “Launch Dialogue Console” must be used at your own responsibility.

I] Select [Launch Dialogue Console...] on the [Utility] menu.
Open the editing screen. The Dialogue Console menu bar appears.

ﬂ Type the PostScript command in the editor screen.
To edit a PostScript file, select [Open] on the [File] menu to open it.
You can search or replace a character string by using the [Search] menu.
B After editing the PostScript file, select [Download Top Window] on [Console]
menu to start printing.
The PostScript file is sent to the printer.

The [Reply from Printer] or the [Printer Says...] box opens, depending on the Post-
Script file you sent.

ﬂ Select [Return To Main Menu] on the [Console] menu to close the PostScript file.
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